CHAPTER

SPREADSHEET PROCESSING

Ql.

What is a Spreadsheet? Discuss its features.

SPREADSHEET:

A spreadsheet, also known as a worksheet, contains rows and columns and is used to
record and compare numerical or financial data.

Spreadsheets only existed in paper format, but now they are most likely created and
maintained through a software program that displays the numerical information in
rows and columns.

Spreadsheets can be used in any area or field that works with numbers and are
commonly found in the accounting, budgeting, sales forecasting, financial analysis,
and scientific fields.

Computerized spreadsheets mimic a paper spreadsheet.

The advantage of using computerized spreadsheets is their ability to update data and
perform automatic calculations extremely quickly.

On a computerized spreadsheet, the intersection of a row and a column is called a
cell.

Rows are generally identified by numbers 1, 2, 3, and so on.
Columns are identified by letters, such as A, B, C, and so on.

The cell is a combination of a letter and a number to identify a particular location
within the spreadsheet, for example A3.

To maneuver around the spreadsheet, you use the mouse or the tab key.

When the contents of one cell are changed, any other affected cell is automatically
recalculated according to the formulas in use.



e Formulas are the calculations to be performed on the data.
e Formulas can be simple, such as sum or average, or they can be very complex.

e Spreadsheets are also popular for testing hypothetical scenarios.

FEATURES OF SPREADSHEET SOFTWARE:

All the spreadsheet software has different features, but some of the basic features of
spreadsheet software are mentioned below.

Grid of Rows and Columns
e A spreadsheet is a collection of rows and columns and made a grid like structure.

e (Columns are assigned character as their name and rows are assigned numbers as their
name to refer them.

e The column and row combines to form a cell address e.g. A12 represent column A
and row 12. It is also called the cell label or address.

e Cell contains data e.g. text, numeric, a formula and a date, that is called cell value.
Formulas

e Formula is a combination of operands and operators. Here operands can be cell
references and values.

Functions

e Functions are built in formulas.

e You can give direct value or cell reference to the function for calculations.
Commands

e (Commands are used to perform operations on the worksheet or its contents.
Text Manipulation

e You can perform some simple text manipulations e.g. combine the textual data of two
cells into a single cell.

Print
e This facility allows you to print your spreadsheet on a printer to get a hard copy.

Q2. Whatis an Interface? Discuss the Interface of Spreadsheet.

STARTING SPREADSHEET:

e To have a better understanding with a spreadsheet you should be familiar with its
interface.

e Interface represents a way through which you can interact with the Spreadsheet
software



THE SPREADSHEET’S INTERFACE:

e Spreadsheet’s interface consists of a grid like structure (word area) and a set of
various tools to perform different operations.

e A gnd like structure is called a worksheet.

e More than one worksheet combined to form a workbook.

e In early days there were only one worksheet in a document but now there can be more
than one worksheet to form 3D-Worksheets.

e [t s like a pad of worksheets.

e It is due to this that data in one worksheet can be used in another worksheet of the
same workbook.

e Spreadsheet interface also contain menu bars, toolbars, and a formula bar.

e Formula bar 1s used to write certain formulas.
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e The Standard toolbar, located beneath the menu bar, has buttons for commonly
performed tasks like adding a column of numbers, printing, sorting, and other
operations.

e Excel let's you customize the toolbar or even display multiple toolbars at the same time.

e The Standard Excel toolbar appears in the figure below.
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Formatting toolbar

e The Formatting toolbar, located beneath the Standard toolbar bar, has buttons for
various formatting operations like changing text size or style, formatting numbers and

placing borders around cells.
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Formula bar

e The formula bar is located beneath the toolbar at the top of the Excel worksheet.
e Use the formula bar to enter and edit worksheet data.

e The contents of the active cell always appear in the formula bar.

e When you click the mouse in the formula bar, an X and a check mark appear.

e You can click the check icon to confirm and completes editing, or the X to abandon

editing.
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Name box

e The Name box displays the reference of the selected cells.

Q3. What is the procedure to enter data in a Worksheet? Discuss basics of a
Worksheet.

e The place where data is entered in spreadsheet is called cell.
e You can enter data in the form of text, numbers, formulas, functions and dates.
e The cell can also hold videos, images, sound files etc.

e There are two states of a cell.

e Active cell When a cell has control on it, it 1s called active cell. Control is showed

with a rectangular frame on the cell.



Passive cell The cell without rectangular frame 1s called passive cells.
To enter data into a cell it must be active.

Now just start to write whatever you wants to enter in the cell. You can also edit the
contents of a cell. For this just make that cell active and change it into edit mode.

To change a cell into edit mode simply double click on it by using mouse or press F2
key from the keyboard.

Like other application software spreadsheets also provide the facility of cut, copy and
paste.

BASICS OF WORKSHEET

Data in a worksheet can have many different forms but the most common forms of
data in a cell are as follows.

Labels

Labels are used to identify a value or series of values e.g. “Marks™ can represents a
column having marks of students. Label should be short and self explanatory. No
mathematical operation can be applied on labels.

Values

Values are numeric data entered in a cell. These values can be whole numbers,
decimals, negative numbers, currency and other types of values including scientific
notations.

Formulas

It is the most powerful feature of spreadsheet. Formula can produce results on the
basis of values. More complex formulas can evaluate logical condition and perform
certain calculations on the basis of their results. All logical condition are evaluated to
either true or false.

Difference between Labels and Values

Values Labels
A value can be numeric constant, date, a | Label is a text entry such as “Marks”, or
formula or a formula’s result. “Name” etc.

Mathematical calculations can be | No mathematical operation can be
performed on values. performed on labels.

Cell References

Reference identifies a cell or a range of cells on a worksheet and tells Microsoft Excel
where to look for the values or data you want to use in a formula.

With references, you can use data contained in different parts of a worksheet in one



formula or use the value from one cell 1n several formulas.

You can also refer to cells on other sheets in the same workbook, and to other
workbooks.

References to cells in other workbooks are called links.

By default, Excel uses the A1 reference style, which refers to columns with letters (A
through IV, for a total of 256 columns) and refers to rows with numbers (1 through
65536).

These letters and numbers are called row and column headings.

To refer to a cell, enter the column letter followed by the row number. For example,
B2 refers to the cell at the intersection of column B and row 2.

Cell Ranges

A collection of cells is called a cell range.
Cell ranges are used in functions.

It is useful when you want to add many cells. For example if you want to add cells
from Al to A123.

It is very difficult and tiresome to write formula for this but we can easily use this
range in a function to calculate the sum e.g. =SUM(A1:A123)

Named Ranges

Named Ranges are a powerful tool in Excel that allows you to assign a meaningful
name to a single cell or a range of cells.

For example, you can assign the name "TaxRate" to cell C1 and then use the name
"TaxRate" anytime you would normally use the cell C1, such as =A5*TaxRate.

There are 3 advantages to using Named Ranges:

Formulas are more readable and meaningful. A formula like =A5*TaxRate is more
meaningful to you when you are working with a complex worksheet.

Named Ranges, by default, always use absolute cell references. Therefore, you don't
have to worry about address translation, which occurs with relative cell references,
when you Copy/Paste or Fill Down/Right cell ranges.

Named Ranges make it easier to create well organized and attractive workbooks. You
can use a named reference, rather than a cell address, in formulas, and then define that
name to a specific cell after you've designed the workbook. With Named Ranges,
you won't have to edit and change the dependent formulas. Just change the reference
of the name.

Valid Range Names

A range name can contain letters, numbers, and underscores, but not spaces or special
punctuation characters. Moreover, it cannot be the same as a normal cell reference.



For example, "AA10" 1s not a valid range name because "AA10" 1s the name of a
normal cell reference (row 10, column "AA").

Adding and Deleting Named Ranges

Q4.

To create a new Named Range from Excel, use the following procedure:
Select the cell or range of cell that you want to assign a name to.

Go to the Insert menu, select define from Name menu item, and type your name in
the text box.

To delete a named range, go to the Imsert menu, select the Name menu item, then
select the name from this list, and click the Delete button.

What is relative and absolute referencing? What is the procedure of linking
worksheets?

RELATIVE REFERENCIN

A relative cell reference in a formula, such as Al, is based on the relative position of
the cell that contains the formula and the cell the reference refers to.

If the position of the cell that contains the formula changes, the reference is changed.

If you copy the formula across rows or down columns, the reference automatically
adjusts. By default, new formulas use relative references. For example, if you copy a
relative reference in cell B2 to cell B3, it automatically adjusts from =A1 to =A2.

ABSOLUTE REFERENCIN

An absolute cell reference in a formula, such as $A$1, always refer to a cell in a
specific location.

If the position of the cell that contains the formula changes, the absolute reference
remains the same.

If you copy the formula across rows or down columns, the absolute reference does
not adjust.

By default, new formulas use relative references, and you need to switch them to
absolute references. For example, if you copy a absolute reference in cell B2 to cell
B3, it stays the same in both cells =§A$1.

LINKING WORKSHEETS

You may want to use the value from a cell in another worksheet within the same
workbook in a formula.

For example, the value of cell Al in the current worksheet and cell A2 in the second
worksheet can be added using the format "sheetname!celladdress".



e The formula for this example would be "=A1+Sheet2!A2" where the value of cell Al

in the current worksheet is added to the value of cell A2 in the worksheet named
"Sheet2".

Q5. Whatis formula? Write down the procedure to apply formula in worksheets.
FORMULA:

e A formula is a mathematical expression that uses numbers, cell references or both.

e Formulae enable you to perform calculations by using values in the worksheet.

e When you use a formula to create a calculation, and you change any of the values
referenced by the formula, Excel automatically recalculates the result.

e You can enter formulae in two ways: type the formula directly in the cell, or point to
the cells that you want the formula to compute.

e Following are arithmetic operators that you can use in formulae.

Operator Description
+ Addition
- Subtraction
ki Multiplication
/ Division
% Percentage
A Exponentiation

Example:

Write =5+7 in a cell and press Enter. It will display 12 as a result in the cell. You can use
different operator for different formulas. You can also use cell references instead of
constant values to calculate formulas.

Q6. Whatis a function? Write down the procedure to apply functions in
worksheets.

FUNCTIONS

e Functions are predefined formulas that perform calculations by using specific values,
called arguments, in a particular order, or structure.

e Functions can be used to perform simple or complex calculations. For example, the
ROUND function rounds off a number in cell A10



e Functions can be a more etticient way ot performing mathematical operations than

formulas.

e For example, if you wanted to add the values of cells A1 through A5, you would type
the formula "=A1+A2+A3+A4+AS ". A shorter way would be to use the SUM

function and simply type "=SUM(A1:A5)".

STRUCTURE OF A FUNCTION

e The structure of a function begins with an equal sign (=), followed by the function
name, an opening parenthesis, the arguments for the function separated by commas,

and a closing parenthesis.

e Function name: For a list of available functions, click a cell and press SHIFT+F3.

e Arguments: Arguments can be numbers, text, logical values such as TRUE or
FALSE, error values such as #N/A, or cell references. The argument you designate
must produce a valid value for that argument. Arguments can also be constants,

formulas, or other functions.

e Some examples of commonly used functions are given below.

Function Example Description
SUM =SUM(B1:B50) finds the sum of cells B1 through B50
AVERAGE| =AVERAGE(F1:F20)| finds the average of cells F1 through F20
_ _ returns the highest number from cells D1
MAX =MAX(D1:D500) through D500
g _ returns the lowest number from cells D1
MIN =MIN(D1:D500) through D500
SQRT —SQRT(A10) eruéls the square root of the value in cell
TODAY —TODAY() returns the current date (leave the
parentheses empty)

FUNCTION WIZARD

e View all functions available in Excel by using the Function Wizard.




Activate the cell where the function will be placed and click the Function Wizard
button on the standard toolbar.

From the Paste Function dialog box, browse through the functions by clicking in the
Function category menu on the left and select the function from the Function name
choices on the right. As each function name is highlighted a description and example
of use is provided below the two boxes.
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Click OK to select a function.

The next window allows you to choose the cells that will be included in the function.
In the example below, cells B4 and C4 were automatically selected for the sum
function by Excel. The cell values {2, 3} are located to the right of the Number 1
field where the cell addresses are listed. If another set of cells, such as B5 and C5,
needed to be added to the function, those cells would be added in the format "B5:C5"
to the Number 2 field.
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o Click OK when all the cells for the function have been selected.

Difference between Formula and Function

Formulas Functions

They are created by the users These are built in programs.




They can pertorm function as required by
the user.

They can only perform the predefined
functions.

A formula has no name.

Function has a unique name.

No parameter is passed to the formula.

Certain arguments are passed to the
function.

Formula 1s a difficult way to perform

It provides easy and efficient process to

calculations.

perform calculations.

Q7.

What is Cell Formatting? Write down the procedure to apply formatting in
worksheets.

CELL FORMATTIN

To enhance the appearance and to improve readability of your worksheets, you can
format the information in worksheet cells either before or after you enter the data.

You can change the fonts or apply attributes such as boldface, italic, underline,
borders, patterns, and colors.

You also can apply numeric and date and time formats.

Many of the formats you will use most often are accessible on the Formatting toolbar.
Additional formatting options are available on the Format menu.

You will get the following Format dialog box
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CREATING CUSTOM FORMAT

You can create your own custom numeric formats for financial or scientific tasks and
create formats for catalog numbers, international currency, and so on.



e Any time you need to display a number 1n a special way, you should consider using a
custom numeric format.

¢ Each number format consists of four parts.

e First part describes the positive numbers, the second describe the negative numbers
third describe zero values and the fourth describe text values.

o Each part is separated by semicolon.

e These parts of format are optional.

o If you specify two the first will be used for positive numbers and zero values and the
second is used for negative numbers.

o If you specify only one, all numbers use the same format and text value use general
format.

Symbols used in Custom Format

Symbol

Meaning

Example

#

Using # insignificant zeros will not
display.

If custom format is #,### then 4500
will be displayed as 4,500

(Period)

It indicated that how many digits
appear to the right of a decimal
pint. The cell display will round to
the number of placeholders to the
right of the decimal pint in the
format.

If the custom format is ###.00 then
2.3 will be displayed as 2.30 and
658 will be displayed as 658.00

It determines that how many digits
will display on either side of a
decimal number.

If custom format is 000 then 7 will
be displayed as 007 and 70 will be
displayed as 070.

A space holder similar to 0
character, except that space is left
for insignificant zero character on
either side of a decimal pint.

If custom format is 0.??? Then for
34876 and 5.6, if displayed
vertically the decimal pint of
34.876 will become under the
decimal point of 2.4
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The format you select for the cell will change the contents of cell according to that
format.

There are separate formats for different data values like currency, date etc.

ALIGNING CELL CONTENTS

Excel automatically aligns entries within a cell, according to the data you enter.
When you enter text in a cell, Excel aligns the data to the left of the cell.
When you enter numbers, Excel aligns them to the right.

You can override this automatic alignment, and specify how you want data aligned: to
the left, to the right, centered, justified or Fill.

In most cases, you will probably want to change the alignment of column headings so
that the text is centered in each cell.

If your worksheet data includes a title, you may also want to center the title over the
worksheet data.
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MERGE CELL AND WRAP TEXT

Q8.

Merge cell option combines two or ore selected cells into a single cell.

The cell reference for a merged cell is the upper left cell in the original selected
range.

Wrap text option wraps text into multiple lines in a cell.

The number of wrapped lines is dependent on the width of the column and the length
of the cell contents.

These two options can be applied by following these steps

Selecting cell or range of cells.

From format menu select cells format cells option.

A dialog box will appear, from this dialog box select alignment tab.
Here select the required option and press ok button.

What is a Chart? Write down the procedure to Create Charts in worksheets.

INTRODUCING CHARTS



e (Charts are visually appealing and make 1t easy for users to see comparisons, patterns,
and trends in data.

e For instance, rather than having to analyze several columns of worksheet numbers,
you can see at a glance whether sales are falling or rising over quarterly periods, or
how the actual sales compare to the projected sales.

CHART WIZARD

e The Chart Wizard brings you through the process of creating a chart by displaying a
series of dialog boxes.

e Enter the data into the worksheet and highlight all the cells that will be included in the
chart including headers.

A | B C
1 Students
_2 |English 34
_3 |Biology 32
4 |Calculus 26
_3 |Physics 28
6_|History 391
=

e Click the Chart Wizard button on the standard toolbar to view the first Chart Wizard
dialog box.

e Chart Type: Choose the Chart type and the Chart subtype if necessary. Click Next.
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e Chart Source Data: Select the data range (if different from the area highlighted in
step 1) and click Next.
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Chart Options: Enter the name of the chart and titles for the X- and Y-axes. Other
options for the axes, grid lines, legend, data labels, and data table can be changed by
clicking on the tabs. Press Next to move to the next set of options.
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Chart Location: Click As new sheet if the chart should be placed on a new, blank
worksheet or select As object in if the chart should be embedded in an existing sheet
and select the worksheet from the drop-down menu.

Chart Wizard - Step 4 of 4 - Chart Location
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= Click Finish to create the chart.
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e Chart Objects List: To select an object on the chart to format, click the object on the
chart or select the object from the Chart Objects List and click the Format button.
A window containing the properties of that object will then appear to make
formatting changes.

¢ Chart Type - Click the arrowhead on the chart type button to select a different type
of chart.

e Legend Toggle - Show or hide the chart legend by clicking this toggle button.

e Data Table view - Display the data table instead of the chart by clicking the Data
Table toggle button.

e Display Data by Column or Row - Charts the data by columns or rows according to
the data sheet.

e Angle Text - Select the category or value axis and click the Angle Downward or
Angle Upward button to angle the selected by +/- 45 degrees.
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Q9. What s page setup of worksheets?

Select Page Setup from the File menu bar to format the page, set margins, and add
headers and footers.

e Page
Select the Orientation under the Page tab in the Page Setup window to make the
page Landscape or Portrait. The size of the worksheet on the page can also be
formatting under Scaling. To force a worksheet to print only one page wide so all the

columns appear on the same page, select Fit to 1 page(s) wide.
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Margins
Change the top, bottom, left, and right margins under the Margins tab. Enter values
in the header and footer fields to indicate how far from the edge of the page this text

should appear. Check the boxes for centering horizontally or vertically on the page.
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» Header/Footer

Add preset headers and footers to the page by clicking the drop-down menus under
the Header/Footer tab.
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To modify a preset header or footer, or to make your own, click the Custom
Header and Custom Footer buttons. A new window will open allowing you to enter text
in the left, center, or right on the page.
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of pages
Format Text - Click this button after highlighting the text to change the font, size, and
style.
Page Number - Insert the page number of each page.
Total Number of Pages - Use this feature along with the page number to create strings
such as "page 1 of 15".
Date - Add the current date.
Time - Add the current time.
File Name - Add the name of the workbook file.
Tab Name - Add the name of the worksheet's tab.
e Sheet
Check Gridlines if you want the gridlines dividing the cells to be printed on the page.
If the worksheet is several pages long and only the first page includes titles for the
columns, select Rows to repeat at top to choose a title row that will be printed at the

top of each page.
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Print Preview

Select Print Preview from the File menu bar to view how the worksheet will
print. Click the Next and Previous buttons at the top of the window to display the pages
and click the Zoom button to view the pages closer. Make page layout modifications
needed by clicking the Page Setup button. Click Close to return to the worksheet or
Print to continue printing.



Q.10 Discuss the process of printing worksheet.

To print the worksheet, select Print from File menu bar.
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Number of copies:

e Print Range - Select either all pages or a range of pages to print.

e Print What - Select selection of cells highlighted on the worksheet, the active
worksheet, or all the worksheets in the entire workbook.

e Copies - Choose the number of copies that should be printed. Check the Collate box
if the pages should remain in order.

Q.11 What is difference between word processor and spreadsheet?

Sr. | Word Processor Spreadsheet

(1) | Word processor provides the facility to | Spreadsheet provides the facility of
create and edit documents. calculations.

(2) | The data in word processor is inserted | The data in spreadsheet is inserted in
in documents. worksheets.

(3) | It provides no data validation facility. | It provides data validation facility.

(4) | It does not provide data analysis | It provides data analysis facility such

facility.

as filter, subtotal, pivot table and
auditing.

(5)

It provides a small number of predefined

It provides many predefined functions




functions to manipulate data.

to manipulate data.

(6) | It does not provide the facility of | It provides the facility of recalculating
automatic recalculating of data. data. The result changes automatically
if the data is changed.
(7) | Conditional formatting is not available | Spreadsheets provide the facility of
in word processors. conditional formatting. Format of data is
changed when it meets a certain criteria.
(8) | Word processor is used to create | Spreadsheet is used to create salary
letters, applications, memos and | sheets, home budgets and balance
reports etc. sheet.
Q.12 What s difference between function and formula?
Sr. | Function Formula
(1) | Function is predefined facility. Formula is defined by the user.
(2) | Function is written in predefined syntax. | Formula is written according to the
user requirements.
(3) | Function may require parameters. Formula does not require parameters.
(4) | Function is identified by a particular [ Formula has no particular name.

name.

)

All functions are formulas.

All formulas are not functions.




